3270 Interface to OMEGAMON® XE and Candle Command Center Using OMEGAVIEW®

Version 300

GC32-9333-00

May 2002

Candle Corporation
201 North Douglas Street
El Segundo, California 90245
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of Figures</td>
<td>5</td>
</tr>
<tr>
<td>Preface</td>
<td>7</td>
</tr>
<tr>
<td><strong>Chapter 1.</strong> Overview</td>
<td>9</td>
</tr>
<tr>
<td>Candle Command Center 3270 Interface</td>
<td>10</td>
</tr>
<tr>
<td><strong>Chapter 2.</strong> Displaying Alerts and Events for Candle Command Center</td>
<td>13</td>
</tr>
<tr>
<td>Overview</td>
<td>14</td>
</tr>
<tr>
<td>3270 Enterprise View</td>
<td>16</td>
</tr>
<tr>
<td>3270 Managed Objects Panels</td>
<td>17</td>
</tr>
<tr>
<td>3270 Events Panels</td>
<td>19</td>
</tr>
<tr>
<td>3270 Attributes Panels</td>
<td>21</td>
</tr>
<tr>
<td>Help is Available</td>
<td>23</td>
</tr>
<tr>
<td><strong>Chapter 3.</strong> Editing Candle Command Center Situations</td>
<td>25</td>
</tr>
<tr>
<td>Situation Administration</td>
<td>26</td>
</tr>
<tr>
<td><strong>Chapter 4.</strong> Accessing a Console</td>
<td>31</td>
</tr>
<tr>
<td>SNA Consoles</td>
<td>32</td>
</tr>
<tr>
<td><strong>Chapter 5.</strong> Accessing MVS-based Reports</td>
<td>37</td>
</tr>
<tr>
<td>MVS-based Products</td>
<td>38</td>
</tr>
<tr>
<td>Authorizing Report Access</td>
<td>39</td>
</tr>
<tr>
<td>Zooming</td>
<td>42</td>
</tr>
<tr>
<td>Accessing Reports from the Action Bar</td>
<td>43</td>
</tr>
<tr>
<td><strong>Chapter 6.</strong> MVS-based Report Summaries</td>
<td>45</td>
</tr>
<tr>
<td>Candle Command Center for CICS/3270</td>
<td>47</td>
</tr>
<tr>
<td>Candle Command Center for DB2plex/3270</td>
<td>48</td>
</tr>
<tr>
<td>Candle Command Center for IMSplex/3270</td>
<td>50</td>
</tr>
<tr>
<td>Candle Command Center for Sysplex/3270</td>
<td>53</td>
</tr>
<tr>
<td>Candle Command Center for MQSeries/3270</td>
<td>55</td>
</tr>
<tr>
<td><strong>Appendix A.</strong> Guide to Candle Customer Support</td>
<td>57</td>
</tr>
<tr>
<td>Base Maintenance Plan</td>
<td>58</td>
</tr>
<tr>
<td>Enhanced Support Services</td>
<td>62</td>
</tr>
<tr>
<td>Customer Support Contact Information</td>
<td>63</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>65</td>
</tr>
</tbody>
</table>
List of Figures

FIGURE 1. Alerts and Events Navigation .................................................. 15
FIGURE 2. Default OMEGAVIEW Main Status Panel ................................. 16
FIGURE 3. Open as Details Panel ............................................................. 17
FIGURE 4. Object Information Panel ....................................................... 18
FIGURE 5. Open as Events Panel for All Managed Objects ......................... 19
FIGURE 6. Open as Events Panel for a Managed Object ............................ 20
FIGURE 7. Open as Attributes Panel ....................................................... 21
FIGURE 8. Expanded Description Panel .................................................. 22
FIGURE 9. Building Situation List ........................................................... 26
FIGURE 10. Situation List ................................................................. 27
FIGURE 11. Formula Panel ................................................................. 28
FIGURE 12. Multiple Predicates Panel ................................................... 28
FIGURE 13. Edit Predicate Panel ........................................................... 29
FIGURE 14. Situation Administration Navigation ..................................... 30
FIGURE 15. Access Console on Enterprise Events .................................... 32
FIGURE 16. Access Console on Enterprise Details ................................... 32
FIGURE 17. Access Console on Managed Object Events ......................... 33
FIGURE 18. Console Error Message ....................................................... 34
FIGURE 19. Access Console Navigation .................................................. 36
FIGURE 20. Add Session Information Panel ........................................... 40
FIGURE 21. Add User CCC Report Authorities Panel .............................. 41
FIGURE 22. OMEGAVIEW CCC Product Report List ............................... 43
Who should read this book

This guide describes the 3270 interface to your OMEGAMON XE and Candle Command Center products, now available in OMEGAVIEW, Version 300.

Note: When using the OMEGAMON XE and Candle Command Center interface, OMEGAVIEW is used primarily for accessing MVS-based reports.

Where to look for more information

For more information related to this product, please see the

- technical documentation CD-ROM that came with your product
- technical documentation information available on the Candle Web site at www.candle.com
- online help provided with this product

Ordering additional documentation

To order additional product manuals, contact your Candle Customer Support representative.

We would like to hear from you

Candle welcomes your comments and suggestions for changes or additions to the documentation set. A user comment form, located at the back of each manual, provides simple instructions for communicating with the Candle Information Development department.

You can also send email to UserDoc@candle.com. Please include "3270 Interface to OMEGAMON XE and CCC Using OMEGAVIEW, V300" in the subject line.
Candle supplies documentation in the Adobe Portable Document Format (PDF). The Adobe Acrobat Reader will print PDF documents with the fonts, formatting, and graphics in the original document. To print a Candle document, do the following:

1. Specify the print options for your system. From the Acrobat Reader Menu bar, select **File > Page Setup...** and make your selections. A setting of 300 dpi is highly recommended as is duplex printing if your printer supports this option.

2. To start printing, select **File > Print...** on the Acrobat Reader Menu bar.

3. On the Print pop-up, select one of the **Print Range** options for
   - All
   - Current page
   - Pages from: [ ] to: [ ]

4. (Optional). Select the Shrink to Fit option if you need to fit oversize pages to the paper size currently loaded on your printer.

**Printing problems?**

The print quality of your output is ultimately determined by your printer. Sometimes printing problems can occur. If you experience printing problems, potential areas to check are:

- settings for your printer and printer driver. (The dpi settings for both your driver and printer should be the same. A setting of 300 dpi is recommended.)
- the printer driver you are using. (You may need a different printer driver or the Universal Printer driver from Adobe. This free printer driver is available at www.adobe.com.)
- the halftone/graphics color adjustment for printing color on black and white printers (check the printer properties under **Start > Settings > Printer**). For more information, see the online help for the Acrobat Reader.
- the amount of available memory in your printer. (Insufficient memory can cause a document or graphics to fail to print.)

For additional information on printing problems, refer to the documentation for your printer or contact your printer manufacturer.

**Contacting Adobe**

If additional information is needed about Adobe Acrobat Reader or printing problems, see the Readme.pdf file that ships with Adobe Acrobat Reader or contact Adobe at [www.adobe.com](http://www.adobe.com).
Introduction

This chapter provides an overview of the Candle Command Center 3270 Interface.

Chapter Contents

Candle Command Center 3270 Interface ..................................................... 10
What is Provided? ....................................................................................... 10
3270 Interface Requirements ................................................................. 10
Using the Candle Management Workstation ............................................ 11
OMEGAVIEW Authority Differs ............................................................... 11
Alternate Access ...................................................................................... 11
Terminology ............................................................................................ 12
Candle Command Center 3270 Interface

What is Provided?

This guide describes the 3270 Interface to the Candle Command Center (CCC) provided by OMEGAVIEW® Version 300. The Enterprise status light on the OMEGAVIEW Main Status panel indicates the health of your enterprise and is the entry to the 3270 interface to the CCC.

You can perform the following tasks for any of your CCC products at a 3270:

- Display alerts, events, and attributes.
- Display situations.
- Expand the formula defining a situation.
- Update the comparison value or comparison operator within a formula.
- Restart or stop a situation.
- Reset an event.

For your CCC products connected to SNA consoles (usually MVS based), you can use a 3270 to:

- Select from a list of consoles connected to the managed system.
- Perform console activities.

For the following CCC products, you can use a 3270 to zoom to their reports:

- CCC for CICS
- CCC for DB2plex
- CCC for IMSplex
- CCC for MQSeries
- CCC for Sysplex

This guide also includes a brief overview of the 3270-viewable reports.

For more details about individual CCC products, see the product documentation and help panels.

3270 Interface Requirements

To access the Candle Command Center on a 3270 monitor, you must do the following:

1. Install OMEGAVIEW release 300 or above.
2. During CICAT configuration, on the Specify OMEGAVIEW Configuration Values panel, answer Y to Connect to a CMS? and Y to Enable CCC 3270 Interface? For details see the CICAT helps and the OMEGAVIEW Configuration and Customization Guide.
3. Install your CCC products. You can install a CCC product in the OMEGAVIEW address space or in its own MVS address space.
4. Define managed objects and situations on your Candle Management Workstation.
5. To enable CCC for CICS report viewing, invoke the GENERATE function at a Candle Management Workstation to generate CICS-related managed objects.

6. To enable console access, define the consoles at a Candle Management Workstation.

   **Note:** The OMEGAVIEW Main Status panel displays the Enterprise Short-term History Bar as the first item under Alert Status. The session name is Enterprise.

---

**Using the Candle Management Workstation**

You must continue to use a Candle Management Workstation (CMW) to define the following Candle Command Center objects:

- managed objects
- initial situations
- components of situation predicates other than the comparison value or operator.
- templates
- user authorities for using Candle Management Workstation
- workgroups and acknowledgements
- policies
- consoles

**OMEGAVIEW Authority Differs**

Note that OMEGAVIEW authority and Candle Management Workstation authority differs:

**OMEGAVIEW**

There are only two authorities: product administrator and general user. Only a product administrator can use the CCC 3270 interface to edit situations. A general user can use any other features of the 3270 interface.

**CMW**

The Candle Management Workstation has several levels of authority for performing various groupings of tasks at a workstation. Authority ranges from product administrator to general user, with varying degrees of authority in between.

**Alternate Access**

There are alternate ways to access Candle Command Center from a 3270:

- If you are an authorized user, you can access CCC for CICS, DB2plex, IMSplex, MQSeries, or Sysplex reports by using the OMEGAVIEW CCC-Reports pulldown menu. From there you can access the supported features of those CCC products.
- You can access CCC for MQSeries directly by using the CCC for MQSeries 3270 interface.
Help Panels

Remember that when you are on any OMEGAVIEW, Candle Command Center, or CICAT panel, you can use the Help key (F1) to get detailed descriptive and usage information for the panel.

Terminology

These are some commonly used Candle Command Center terms:

Attribute

Characteristic of a managed system. For example:
- storage utilization
- number of CICS transactions
- number of messages in an MQSeries dead-letter queue

Predicate

Comparison of attributes to thresholds. For example:
- storage utilization exceeding 90%
- number of CICS transactions exceeding two-hundred thousand
- number of messages in an MQSeries dead-letter queue exceeding zero

Situation

Logical combination of one or more predicates or situations which resolve to either true or false.

State

Severity of a situation, such as normal, warning, or critical.

Template

Assignment of situations to states. Can be applied to any of your managed objects.

Managed system

Subsystem, node, server, or group or combination of these. Managed object

Managed object

Instance of a template monitoring a managed system or systems.

Aggregate

Set of managed systems or set of aggregates.

Event

Occurrence of a situation becoming true on a monitored managed system or set of systems.
2

Displaying Alerts and Events for Candle Command Center

Introduction

This chapter provides information on CCC alerts and events using OMEGAVIEW.

Chapter Contents

- Overview .................................................. 14
- Observing Alerts and Their Causes ..................... 14
- Creating Customized Enterprise View ................. 14
- CMW Definitions ........................................ 14
- Disabling Enterprise Status Item .................... 14
- Navigation Chart ........................................ 14
- Navigation for Alerts and Events ..................... 15
- 3270 Enterprise View .................................. 16
  - Default OMEGAVIEW Main Status Panel ............ 16
  - CMS Connection Status ................................ 16
  - Enterprise Status Item ................................ 16
  - Enterprise Status Item Actions ..................... 16
- 3270 Managed Objects Panels ......................... 17
  - Open as Details ....................................... 17
  - Actions for Objects .................................. 17
  - Object Information ................................. 18
- 3270 Events Panels .................................. 19
  - Accessing Events .................................... 19
  - Open as Events Panel ................................ 19
  - Events for a Managed Object ....................... 20
  - Resetting Events .................................... 20
- 3270 Attributes Panels ................................. 21
  - Open as Attributes .................................. 21
  - Expanded Description ............................... 22
- Help is Available ....................................... 23
  - For Detailed Information ........................... 23
Overview

Observing Alerts and Their Causes
Using OMEGAVIEW, you can observe alerts and the events causing the alerts from any of your Candle Command Center products. Display panels show you:
- managed objects and their short- and long-term status bars
- events, situation states, and attributes

Creating Customized Enterprise View
You can create your own customized OMEGAVIEW panel that includes the Enterprise status item (short-term history bar):
- Pull down the File menu.
- Select the Panel Editor
- See the OMEGAVIEW documentation for more details.

CMW Definitions
Use your Candle Management Workstation to define or modify managed objects, templates, or situations for all your CCC products.

Disabling Enterprise Status Item
To disable the Enterprise Status Item (short-term history bar) from appearing on the OMEGAVIEW Main Status panel:
1. Pull down the Tools menu.
2. Select Default Status Panel Builder.
3. Change Include Enterprise Status to No.

Navigation Chart
Figure 1 on page 15 shows the navigation, panels, and actions involved in displaying Candle Command Center alerts and events.
Navigation for Alerts and Events

FIGURE 1. Alerts and Events Navigation
3270 Enterprise View

Default OMEGAVIEW Main Status Panel
As shown in Figure 2, if you enabled Enterprise Status during OMEGAVIEW CICAT configuration, the default OMEGAVIEW Main Status panel includes the Enterprise status item (short-term history bar).

FIGURE 2. Default OMEGAVIEW Main Status Panel

CMS Connection Status
The status light above the Enterprise light indicates the health of the connection between OMEGAVIEW and the Candle Management Server for the SDM bridge agent. Session name is CMSCON.

Enterprise Status Item
This status light shows the state of your enterprise for the last 15 minutes. It is the item listed after the CMS connection under Alert Status and is preceded by an action entry field. Session name is Enterprise.

Enterprise Status Item Actions
You can use the following actions next to the Enterprise status item:
- S (Show details) lists the managed objects in your enterprise with their current and recent status. If you are managing a large enterprise, take this action first and then look at the events causing an object to be in a critical or warning state.
- E (Open as Events) displays the events for your enterprise. They are arranged by state (severity) and aggregation (object grouping).
Open as Details

For enterprise, Figure 3 shows a list of all managed objects and their short-term history bars.

FIGURE 3. Open as Details Panel

Actions for Objects

On the Open as Details panel, you can use the following actions on a selected object:

- S (Show details) displays the objects within an aggregate.
- E (Open as Events) displays the events for a selected managed object. See “3270 Events Panels” on page 19.
- I (Information) displays short- and long-term history bars for an aggregate or object. See the panel below.
- A (Access Console) enables you to select a console associated with the managed system. See the chapter “Accessing a Console” on page 31.
Object Information

Using the I (Information) action you can display short- and long-term history bars for a selected managed object. Figure 4 shows an example of an object information panel.

FIGURE 4. Object Information Panel

KMVCCINF  Managed Object Information

Name . . . . : MQSeries Manager

Last 4 hours  Last 15 minutes

___ ___ ___ ___  ___________

F1=Help  F12=Cancel
3270 Events Panels

Accessing Events

To view events, use the E (Open as Events) action
- on the Enterprise History Bar to see all events in your enterprise
- on an aggregate or object shown in the Managed Objects List to see related events

Open as Events Panel

Figure 5 is a sample Open as Events panel. In this example, you used action E on the Enterprise History Bar. For all managed objects, these are the events that caused situations to occur. Events are arranged by situation state, aggregate, subordinate aggregate, and then object.

FIGURE 5. Open as Events Panel for All Managed Objects
Events for a Managed Object

When you use the Open as Events action on a listed aggregate or object, you see a panel showing events related to the selected aggregate or object, as shown in Figure 6. The panel is similar to the Open as Events panel shown above.

FIGURE 6. Open as Events Panel for a Managed Object

Resetting Events

You can use action code R (Reset event) next to any event. This action removes the specific event from further events displays. However, if the situation for the associated managed object becomes true again, the event will appear.
3270 Attributes Panels

Open as Attributes

When you cursor select an event on any Open as Events panel, you see the Open as Attributes panel, as shown in Figure 7. This panel shows you the state, situation, node, date and time, and predicate as well as the specific attributes that caused the selected event to occur.

FIGURE 7. Open as Attributes Panel

```
KMVCCATR              OMEGAMON CICS
Open as Attributes

State of...: Critical
Situation..: OMEGAMON_ALERT_critical
On node....: CCCDS18
Date/Time..: 09/08/98 15:08:43

More: +

Initial Attributes

*PREDICATE :
<SYSTEM.PARMA("SITNAME", 'OMEGAMON_ALERT_critical', 2

Status_Item.Action_Description
Status_Item.Comments
Status_Item.Current_State        Critical
Status_Item.Data
Status_Item.Description
Status_Item.End_Fix_Time
Status_Item.Origin_Node          CCCDS18
Status_Item.Problem_Description
Status_Item.Session_Name         CCCDS18
Status_Item.Start_Fix_Time
Status_Item.Status_Name          WICES
Status_Item.Transient_Text
Status_Item.Type
Status_Item.Update_Timestamp     0980310131802000
Status_Item.User_Text

F1=Help  F4=Expand  **=Bkwd  F8=Fwd  F12=Cancel  F16=Find**=FindNext
F18=Zoom to CCC-Report
```
Expanded Description

A description on an Attributes panel exceeding two lines is surrounded by < and >. To see the full description, place the cursor at the description and press F4 (Expand). In Figure 8, the predicate is expanded.

FIGURE 8. Expanded Description Panel

KMVCATR OMEGAMON_CICS

Situation: OMEGAMON_ALERT_Critical
Attribute: *PREDICATE

Value @ 09/08/98 15:10:43
-------------------------------------------------------------

SYSTEM.PARMA("SITNAME", "OMEGAMON_ALERT_Critical", 23) AND
SDITABLE.SDICSTAT = 'CRITICAL'

F1=Help  F12=Cancel
Help is Available

For Detailed Information
For detailed descriptive and usage information, use the Help key (F1) when you are on any OMEGAVIEW, Candle Command Center or CICAT panel.
Introduction

This chapter discusses the details of situation administration using OMEGAVIEW.

Chapter Contents

- Situation Administration ................................................. 26
  - Overview ............................................................... 26
  - Listing Situations ..................................................... 26
  - Building Situations .................................................. 26
  - Situation List .......................................................... 27
  - Resetting Situations .................................................. 27
  - Expanding a Situation ................................................. 28
  - Showing a Formula to Edit .......................................... 28
  - Multiple Predicates .................................................. 28
  - Editing the Predicate ................................................. 29
  - Navigation Chart ...................................................... 29
  - Situation Administration Navigation .............................. 30
Situation Administration

Overview
If you have administrator authority, you can access Situation Administration from the OMEGAVIEW action bar to
- list situations
- display situation formulas
- adjust situation predicates
- stop and restart situations
To define the entire situation, or other CCC objects, you must continue to use a Candle Management Workstation.

Listing Situations
To list the situations defined for your enterprise:
4. Go to the OMEGAVIEW Main Status panel action bar.
5. Select Tools.
6. Select Configuration Manager.
7. Select Options.
8. Select Situation Administration.
You can take the following fastpaths:
1. Go to the Action Bar entry field.
2. Enter TC.
3. Enter OI.

Building Situations
If you have defined a substantial number of situations for your enterprise, it may take a little time to construct the Situation List. While the building is in progress, OMEGAVIEW shows you the percent of building that has been completed, as shown in Figure 9.

FIGURE 9. Building Situation List

|................|
Percent Complete: nn%
**Situation List**

Figure 10 shows an example of an enterprise Situation List.

**FIGURE 10. Situation List**

<table>
<thead>
<tr>
<th>KMVCCADD</th>
<th>Situation List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type an action code, then press Enter.</td>
<td></td>
</tr>
<tr>
<td>R=Restart, T=Stop, S=Show formula, X=Expand</td>
<td></td>
</tr>
<tr>
<td>Situation(s) 25 to 32 of 701</td>
<td></td>
</tr>
<tr>
<td>S CICSplex_delay_within_CICS</td>
<td></td>
</tr>
<tr>
<td>Service Level failure due to internal CICS components</td>
<td></td>
</tr>
<tr>
<td>_ CICSplex_CSMI_delay_in_FCP</td>
<td></td>
</tr>
<tr>
<td>Service Level failure (CSMI) with excessive time in File Control</td>
<td></td>
</tr>
<tr>
<td>_ CICSplex_CSM5_delay_copy</td>
<td></td>
</tr>
<tr>
<td>Service Level failure (CSM5) with excessive time spent in DL/I</td>
<td></td>
</tr>
<tr>
<td>_ CICSplex_CSM5_delay_in_DLII</td>
<td></td>
</tr>
<tr>
<td>Service Level failure (CSM5) with excessive time spent in DL/I</td>
<td></td>
</tr>
<tr>
<td>_ CICSplex_Fuction_Ship_delays</td>
<td></td>
</tr>
<tr>
<td>Service Level failure (CSM*) in any function shipping request</td>
<td></td>
</tr>
<tr>
<td>_ CICSplex_Performance_Index</td>
<td></td>
</tr>
<tr>
<td>Service Level failure</td>
<td></td>
</tr>
<tr>
<td>_ CICSplex_Service_Class_Deleted</td>
<td></td>
</tr>
<tr>
<td>IBM or Candle service class definition not available</td>
<td></td>
</tr>
<tr>
<td>_ CICSplex_Sympathy_Degradation</td>
<td></td>
</tr>
<tr>
<td>Service Level failure with excessive time spent in MRO or ISC</td>
<td></td>
</tr>
</tbody>
</table>

**Resetting Situations**

Two action codes are available on the Situation List to reset a selected situation for any of your CandleNet Command Center products. Place the cursor next to the situation whose status you want to change.

- To resume evaluating the selected situation for its associated managed systems, enter action code **R** (Restart).
- To stop the situation from being evaluated, enter action code **T** (Stop).

These actions take a little time. As a result of entering a restart or stop action:

1. A progress bar displays with the message: **Building Node List. Please wait...**
2. The Situation Node Status panel lists Managed System, System List, Managing System, and Status for each node.
3. Press Enter to confirm the restart or stop the action.
4. The action is performed for all online nodes.
5. A progress bar displays while the node list is reconstructed.
6. The Situation Node Status panel redisplays:
   - If the action was restart, the Status field shows **Restarted**.
   - If the action was stop, the Status field shows **Stopped**.
7. Press Enter to return to the Situation List.
Expanding a Situation

If a situation name or description is too long to fit on the Situation List panel, you can use action code X next to the situation to display the complete information.

Showing a Formula to Edit

To edit a formula, you must use action S (Show Formula) next to the situation on the Situation List.

CandleNet Command Center uses the formula to evaluate whether a situation is true for a managed object. Figure 11 shows an example of a Formula panel.

**FIGURE 11. Formula Panel**

Press Enter to continue the edit process.

Multiple Predicates

If the situation you selected is composed of more than one predicate, the Multiple Predicates panel displays, as shown in Figure 12 on page 28. Select the predicate you want to edit.

**FIGURE 12. Multiple Predicates Panel**

Press Enter to continue the edit process.
After you edit a predicate, you return to this panel in case you want to select another predicate to edit.

**Editing the Predicate**

When you select a predicate, the Edit Predicate panel displays. You can use this panel to modify the comparison operator and/or the comparison value. Figure 13 shows an example of an Edit Predicate panel.

**FIGURE 13. Edit Predicate Panel**

You edit the comparison operator and comparison value fields as follows:

- Pressing F4 (Prompt) while the cursor is in the comparison operator field displays a list of valid logical operators from which to choose.
- Editing the value field varies depending on the type of value:
  - **Numeric** Enter a signed or unsigned whole or decimal numeric value. You can enter up to eight integers.
  - **String** You can enter a character string of up to 72 characters. You must use a Candle Management Workstation to enter a comparison value string exceeding 72 characters.
  - **Enumerated list** Press F4 (Prompt) to display a prompt list and select from the list.

Once you edit a situation, it is automatically restarted by the Candle Management Server so that the modified formula is recognized.

**Navigation Chart**

Figure 14 on page 30 shows the navigation, panels, and actions involved in situation administration at a 3270.
Figure 14. Situation Administration Navigation
Introduction

This chapter provides information on accessing a console using SNA protocol.

Chapter Contents

SNA Consoles ................................................................. 32
Overview ................................................................. 32
Requirements ............................................................ 32
Using Action Code A .................................................... 32
Selecting a Console ...................................................... 33
Applid Considerations .................................................. 33
Using the Console ........................................................ 33
Undefined Console ....................................................... 33
Switching Back to OMEGAVIEW ...................................... 34
Scenario Using Access Console ........................................ 34
Navigation Chart ......................................................... 35
Access Console Navigation ............................................ 36
SNA Consoles

Overview
The Candle Command Center 3270 interface enables you to access a console from a selected managed system or event.

Requirements
- The console is connected to the managed system using SNA protocol. This is usually MVS-based.
- The console was previously defined at a Candle Management Workstation.

Using Action Code A
Use action code A to access the console on any of these CCC 3270 panels. Figure 15 shows Open as Events for the Enterprise, which lists all events.

FIGURE 15. Access Console on Enterprise Events

```plaintext
KMVCCEVT                        Enterprise
                                Open as Events

S=Select event, R=Reset event, Z=Zoom to CCC-Report, A=Access console
More:  +>

Events as of 18:25:34

---

Figure 16 shows Open as Details for the Enterprise, which lists all managed systems.

FIGURE 16. Access Console on Enterprise Details

```plaintext

Figure 17 on page 33 shows Open as Events for a managed system, which lists the events occurring on the selected system.
Selecting a Console

The console you access will be connected to the selected managed system or to the managed system associated with the selected event.

If more than one console was defined for the managed system, a list of eligible consoles displays for you to make your selection. Otherwise you proceed directly to the console.

Applid Considerations

Consoles are accessed by the applid portion of the console address.

To access a console, the applid portion of the console address must be recognized by the same network domain as OMEGAVIEW.

If you define the same applid in more than one console address and you select more than one console name with the same applid, you will access the first console selected. For example, if you select console TSO SYSA and then select console TSO DEVT, you will access console TSO SYSA both times.

Using the Console

Once you select a console, you are at the console. It is the console that you had associated with the managed system you selected.

You must log onto the console using your normal console user ID and password or via the appropriate user data. Then you can proceed to use the console to investigate the cause of the alert or perform any other necessary console activities.

Undefined Console

If you use action code A to access a console and you see the message shown in Figure 18 on page 34, an SNA console was not previously defined for the managed system. Prior to access, you must first define the console for the system in question at a Candle Management Workstation.
Switching Back to OMEGAVIEW

The default OMEGAVIEW switch key is PA2. The behavior of the switch key depends on where you originated the console access.

- If you used the Access Console action on the Open as Details panel, the switch key returns you to the Open as Details panel or to the console selection panel, if there is more than one associated console.

- If you used the Access Console action on an Open as Events panel, the switch key returns you to the OMEGAVIEW Main Status panel.

**Important:**

If PA2 presents a conflict with your console application, you can use OMEGAVIEW to define a different key.

Scenario Using Access Console

Here is a typical example of how you can use the access console action to research and correct a detected problem.

1. On the OMEGAVIEW Main Status panel, you notice that the Enterprise status item indicates a critical event has occurred; the status light turned red.
2. You tab to the Enterprise status item and Enter S to show details.
3. On the Enterprise Open as Details panel, you determine that the status for the CICSPlex managed object is critical; it displays red.
4. You enter S next to CICSPlex, which is an aggregate object, to show the regions comprising CICSPlex.
5. On the list of regions comprising the CICSPlex aggregate, you can see which region is critical; it displays red.
6. Enter A, the Access Console action code, next to the CICS region that is in critical status.
7. From the list of connected consoles, select a console that is connected to the CICS region where the alert originated.
8. At the console panel, you log onto the console.
9. You issue CEMT transactions to analyze the current configuration.
10. You can issue any other transactions to research or correct the problem.
11. You can use the switch key (PA2 is the default) to return to OMEGAVIEW to review the problem data, such as the event, situation, attribute, and reoccurrence of the event.
12. When you are finished using the CICS console, use the switch key (PA2) to return to OMEGAVIEW to continue monitoring the various managed systems and events in your enterprise.

Navigation Chart

Figure 19 on page 36 shows the navigation, panels, and actions involved in accessing a console at a 3270.
Access Console Navigation

FIGURE 19. Access Console Navigation

```
+-------------+
|KMV$DFLT     |
| Enterprise  |
| Status Item |
| OMEGAVIEW   |
| Main Status |
+-------------+

| KMVCCDRT    |
| Enterprise  |
| Open as Details |

| KMVCCEVT    |
| Managed Obj |
| Open as Events |

| KMVCCOAC    |
| Select Console |

| Single console |
| Open as Details |
| PA2 |
| If action A from Console |

| Multiple consoles |
| Open as Events |
| PA2 |
| If action A from |

| A=Access Console |

| S=Show Details |
| E=Events |

| E=Events |
```

```
Introduction

This chapter discusses the various methods for accessing MVS-based reports.

Chapter Contents

MVS-based Products .......................................................... 38
Products Supported ........................................................ 38
Overview ................................................................. 38

Authorizing Report Access .................................................. 39
Requirements ............................................................... 39
Administrator Authority .................................................. 39
CCC Session Types ......................................................... 39
Local Session Requirement .............................................. 39
Remote Session Requirement ........................................... 39
Candle Command Center for MQSeries JCL Requirement ............ 39
Adding a CCC for MQSeries Session ..................................... 40
Granting Authority .......................................................... 40

Zooming ......................................................................... 42
Overview ....................................................................... 42
Accessing Reports from Open as Events ................................ 42
Accessing Reports from Open as Attributes .......................... 42
Accessing an OMEGAMON II Host Session ......................... 42

Accessing Reports from the Action Bar ................................. 43
Alternate Report Access ...................................................... 43
Authority Required .......................................................... 43
Selecting a Product ............................................................ 43
MVS-based Products

Products Supported
You can use the Candle Command Center 3270 interface to access reports for these products:

- CCC for CICS
- CCC for DB2plex
- CCC for IMSplex
- CCC for MQSeries
- CCC for Sysplex

You can also access data written to the Subsystem Logging Facility (SLF) by an MVS-based CCC product.

Overview
This chapter describes

- what authorization is required and how to grant authority
- how to zoom to a report from an event or attribute display
- how to access a report or SLF data from the CCC-Report pulldown
Authorizing Report Access

Requirements
Before you can access report or SLF information from MVS-based Candle Command Center reports, authorization is required. You are granted authorization for each product separately. Also, to access Candle Command Center for MQSeries reports a remote session must be defined.

The requirements are the same whether you access report information by zooming from event or attribute panels, or by selecting CCC-Reports from the Action Bar.

Administrator Authority
You need Administrator authority to:
- add, change, or delete sessions
- grant access authority to CCC report or SLF information.

CCC Session Types
A CCC session is distributed as either a local or remote session. A local session is an application that runs in the OMEGAVIEW region. The supported local sessions are VVV for CICS, DB2plex, IMSplex, and SYSplex.

Because a remote session runs in a region external to OMEGAVIEW, OMEGAVIEW must establish a virtual session to invoke the remote session through VTAM. The supported remote session is Candle Command Center for MQSeries.

Local Session Requirement
For local session access, you must authorize users as explained in “Granting Authority” on page 40.

Remote Session Requirement
For remote session access, you must
- add a session, as explained in “Adding a CCC for MQSeries Session” on page 40.
- authorize users as explained in “Granting Authority” on page 40.

Candle Command Center for MQSeries JCL Requirement
Before you can add an Candle Command Center for MQSeries session, you must add the Candle Command Center for MQSeries dataset

`rhilev.RKANPENU`

and the RKANPENU DD statement in the OMEGAVIEW started task JCL.
**Adding a CCC for MQSeries Session**

Since CCC for MQSeries is a remote session, you must add the session to OMEGAVIEW. To add the CCC for MQSeries session to OMEGAVIEW, follow these steps:

1. Select **Tools** from the Action Bar.
2. Select **Configuration Manager** from the Tools menu.
3. On the Configuration Manager, enter **A** in the Action field and the session name. You can also use the **C** (Change) and **D** (Delete) actions on the Configuration Manager to change session information or delete a session.
4. On the Session Type panel, select the CCC-MQ session to add.
5. Complete the fields on the Add Session Information panel.

Figure 20 shows the Add Session Information Panel.

**FIGURE 20. Add Session Information Panel**

![Add Session Information Panel](image)

For information about a specific field, place the cursor on the field and press F1.

If your terminal does not display all the fields on one panel, press F8 to display the remaining fields.

The new session appears on the Configuration Manager panel with status **INFO**, since the session is used for informational reasons only.

**Granting Authority**

As a product administrator, you must authorize users to access report information. You grant separate access authority for each MVS-based CCC product and for the Subsystem Logging Facility.

Use the following procedure to authorize CCC report or SLF access.

1. Select **Tools** from the Action Bar.
2. Select **Configuration Manager** from the Tools menu.
3. On the Configuration Manager, select **Options** from the Action Bar.
4. Select **User Authorities** from the Options menu.
5. On the User Authorities panel, enter **A**, and the User ID that you want to add. You can also use action **C** (Change) or **D** (Delete) for existing users.
6. If an add or change, press F14 on the Add (or Change) User Authorities panel.
7. On the Add (or Change) User CCC Report Authorities panel, enter Yes next to the products the user may access. You can press F4 to toggle between Yes and No. You can press F1 for a description of each field. Figure 21 shows the Add User CCC Report Authorities Panel.

**FIGURE 21. Add User CCC Report Authorities Panel**

![Add User CCC Report Authorities Panel](image)

8. Press Enter to save the settings and redisplay the User Authorities panel.
9. After you add or change user authorities, the user must log off OMEGAVIEW, and log on again to activate the changes.
Overview
You can use the Candle Command Center 3270 interface to access relevant MVS-based product reports from events and attributes panels. The zoom destination varies depending on the Candle Command Center product.

Accessing Reports from Open as Events
You can reach CCC product reports from an Open as Events panel. Enter action code Z (Zoom to CCC-Report) next to an MVS-based event to view a relevant CCC report.

Accessing Reports from Open as Attributes
You can also reach a relevant report from an Open as Attributes panel. Use F18 (Zoom to CCC-Report).

Accessing an OMEGAMON II Host Session
When researching the cause of an alert, you may want to review conditions raised by an OMEGAMON II product. To access an OMEGAMON II host session, use the terminal emulator adapter feature of CandleNet Portal.

The terminal emulator adapter turns a view into a 3270 or 5270 interface so you can connect to any TN3270 or TN5250 host system (such as MVS or OS/400) using TCP/IP. The terminal emulator adaptor provides for simple terminal emulation. It also provides a scripting language interface that:

- Permits you to record (capture) a host session. As you interact with a host session, the session is recorded as a set of script commands that can be saved under a name you specify and played back at a later time. This allows you to automate navigation to a specific set of screens.

- Permits you to author complex scripts containing custom functions for manipulating host sessions.
Accessing Reports from the Action Bar

Alternate Report Access

Instead of zooming as described in “Zooming” on page 42, there is another way to access MVS-based CCC reports. You can select CCC-Reports from the Action Bar on the OMEGAVIEW Main Status panel. This leads you to the main report menu for a selected MVS-based CCC product. You can also use CCC-Reports on the Action Bar to access data written to the Subsystem Logging Facility (SLF) by an MVS-based CCC product.

Authority Required

Once you have report or SLF authority, OMEGAVIEW displays the CCC-Reports choice on the OMEGAVIEW Main Status panel Action Bar.

If you are not authorized to access SLF or reports for any product, the CCC-Reports option does not appear on the Action Bar.

Selecting a Product

Use the following procedure to access MVS-based OMEGAVIEW report or SLF information, as shown in Figure 22.

1. From the OMEGAVIEW main panel, select CCC-Reports.
2. From the OMEGAVIEW CCC Product Report List, cursor select the session whose reports you want to view. The Subsystem Logging Facility is listed as a session.

FIGURE 22. OMEGAVIEW CCC Product Report List

<table>
<thead>
<tr>
<th>Session</th>
<th>Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>_ OS</td>
<td>CCC Reports for Sysplex</td>
<td>Available</td>
</tr>
<tr>
<td>_ CP</td>
<td>CCC Reports for CICS</td>
<td>Available</td>
</tr>
<tr>
<td>_ IP</td>
<td>CCC Reports for IMSplex</td>
<td>Available</td>
</tr>
<tr>
<td>_ DP</td>
<td>CCC Reports for DB2plex</td>
<td>Available</td>
</tr>
<tr>
<td>_ ZMQ0</td>
<td>CCC Reports for MQSeries</td>
<td>Available</td>
</tr>
<tr>
<td>_ ZYX</td>
<td>Subsystem Logging Facility</td>
<td>Available</td>
</tr>
</tbody>
</table>

F1=Help  **=Bkwd  **=Fwd  F12=Cancel  F14=Find

3. You reach the selected product’s main report menu. From there you can navigate to other reports for the product.
4. For more information about using the session displayed, refer to the online help.
5. To return to OMEGAVIEW, press F3 to exit the session.
Accessing Reports from the Action Bar
MVS-based Report Summaries

Introduction

This chapter summarizes the reports provided by CCC for CICS, DB2plex, IMSplex, Sysplex, and MQSeries. Use OMEGAVIEW Version 300 to display these reports on your 3270 monitor.

For more information about an OMEGAMON XE or CCC product, see the product’s documentation and help panels.

Chapter Contents

Candle Command Center for CICS/3270 ................................................................. 47
  Introduction ........................................................................................................ 47
  What Candle Command Center for CICS/3270 provides ......................... 47
Candle Command Center for DB2plex/3270 ......................................................... 48
  Introduction ........................................................................................................ 48
  What Candle Command Center for DB2plex Provides ................................. 48
  Coupling Facility Reports - Overview .............................................................. 48
  Database Locks Reports - Overview ................................................................. 48
  Group Buffer Pools Reports - Overview .......................................................... 49
  Group Object Analysis Reports - Overview ..................................................... 49
  Threads Reports - Overview ............................................................................ 49
Candle Command Center for IMSplex/3270 ......................................................... 50
  Introduction ........................................................................................................ 50
  What Candle Command Center for IMSplex Provides ................................. 50
  CF Shared Queues Reports - Overview ............................................................ 50
  Coupling Facility Reports - Overview .............................................................. 51
  Database Locks Reports - Overview ................................................................. 51
  MQSeries Status Reports - Overview ............................................................... 51
  Multiple Systems Coupling Reports - Overview .......................................... 51
  Response Time Analysis Reports - Overview ................................................. 52
  Startup Parameters Reports - Overview .......................................................... 52
  Online TRF Class Reports - Overview ............................................................. 52
  Online TRF DLI Reports - Overview ............................................................... 52
Candle Command Center for Sysplex/3270 ................................. 53
  Introduction .......................................................................... 53
  What Candle Command Center for Sysplex/3270 Provides .......... 53
Candle Command Center for MQSeries/3270 ............................... 55
  Introduction .......................................................................... 55
  Accessing CCC for MQSeries Report Information from OMEGAVIEW .. 55
  What CCC for MQSeries/3270 Provides ................................. 55
  CCC for MQSeries/3270 Reports ........................................... 56
Introduction

Candle Command Center for CICS/3270 monitors multiple CICS regions, connected or not, as a single unit on an MVS host. You can monitor multiple CICS regions on multiple MVS images or multiple CICS regions in a single image.

With the use of reports and service level analysis, the 3270 interface for Candle Command Center for CICS allows you to view summarized transaction data and efficiently monitor your CICS regions. You can also zoom to an underlying OMEGAMON XE for CICS panel to gather detailed information about a region or task.

What Candle Command Center for CICS/3270 provides

Candle Command Center for CICS/3270 enables you to:

- Monitor the CICS regions that compose the CICSpex and reports on their resource utilization.
- Monitor the connections between the CICS regions and reports on their status, capacity, and throughput.
- Monitor and report on MQ connections for CICS regions.
- Monitor transactions that run in the CICSpex, regardless of the regions where they were executed, the resources they use, or the connections they span.
- Produce online historical reports of CICS regions and transaction performance. These reports show current and historical information about service levels, CICS regions, and links between CICS regions.
Introduction
Candle Command Center for DB2plex brings a consolidated view of multiple DB2 systems to your Candle Management Workstation (CMW).

The Candle Command Center for DB2plex/3270 reports display enterprise-wide performance and status information, including a global view of:

- thread activity
- database lock conflicts in a data sharing environment
- LOCK1 and SCA coupling facility structures
- group buffer pool structures
- object analysis data

What Candle Command Center for DB2plex Provides
Candle Command Center for DB2plex provides monitoring capabilities for these five groups:

- DB2plex Coupling Facility
- DB2plex Database Locks
- DB2plex Group Buffer Pools
- DB2plex Group Object Analysis
- DB2plex Threads

Coupling Facility Reports - Overview
The Coupling Facility reports provide detailed coupling facility structure information about your LOCK1 and SCA structures.

Using the Coupling Facility reports you can:

- verify the status of all connections to a structure
- monitor lock structure utilization over a period of time
- view comprehensive global and false contention data

Database Locks Reports - Overview
The Database Locks reports provide detailed lock conflict information about your database locks.

Using the Database Locks reports you can:

- identify global database lock conflicts within a data sharing group
- evaluate and analyze database lock conflicts
- identify lock owners and waiters for a database lock
- identify the lock hierarchy chain for a specific application thread
- monitor database lock activity

**Group Buffer Pools Reports - Overview**

The Group Buffer Pools (GBP) reports provide detailed coupling facility structure information about your group buffer pool structures.

Using the Group Buffer Pools reports you can:
- monitor structure utilization over a period of time
- verify the status of all connections to a structure
- view GBP statistics for a data sharing group and GBP structure

**Group Object Analysis Reports - Overview**

The Group Object Analysis reports provide detailed object analysis information about DB2 databases.

Using the Group Object Analysis reports you can:
- monitor and evaluate object allocation data for DB2 databases
- evaluate and analyze spacename allocation data for a specific DB2 database

**Threads Reports - Overview**

The Threads reports provide detailed thread activity information about your DB2 threads.

Using the Threads reports you can:
- identify all active threads within a data sharing group
- evaluate and analyze thread activity for application threads
- monitor and track thread activity over a period of time
- view statistics for an application thread
Introduction

Candle Command Center for IMSplex brings you a consolidated view of multiple IMS systems to your Candle Management Workstation (CMW).

The Candle Command Center for IMSplex/3270 reports display enterprise-wide performance and status information, including:

- a global view of database lock conflicts in a data sharing environment
- the connection status of Coupling Facility structures
- a global view of transaction response times
- the link status and queue counts of Multiple Systems Coupling (MSC) physical and logical links
- MQ status for an IMS subsystem
- a global view of coupling facility shared queues
- IMS startup parameters
- TRF class and DLI profile information

Note: The Response Time Analysis (RTA) and MSC features of Candle Command Center for IMSplex are not available if you are monitoring a DBCTL system.

What Candle Command Center for IMSplex Provides

Candle Command Center for IMSplex provides monitoring capabilities for these nine groups:

- IMSplex CF Shared Queues
- IMSplex Coupling Facility
- IMSplex Database Locks
- IMSplex MQSeries Status
- IMSplex Multiple Systems Coupling
- IMSplex Online TRF Class
- IMSplex Online TRF DLI
- IMSplex Response Time Analysis
- IMSplex Startup Parameters

CF Shared Queues Reports - Overview

The CF Shared Queues reports provide you with a global view of coupling facility shared queues.

Using the CF Shared Queues reports you can view detailed information about IMS transactions that are currently on the input queue.
Coupling Facility Reports - Overview
The Coupling Facility reports provide detailed coupling facility structure information about your cache and lock structures.

Using the Coupling Facility reports you can:
- verify the connection status of your cache and lock structures
- monitor lock structure utilization over a period of time

Database Locks Reports - Overview
The Database Locks reports provide detailed lock conflict information about your database locks.

Using the Database Locks reports you can:
- evaluate and analyze database lock conflicts
- identify lock owners and waiters for a database lock
- identify the lock hierarchy chain for a specific transaction or application
- monitor database lock activity
- track transaction lock processing over a period of time

MQSeries Status Reports - Overview
The MQSeries Status reports provide detailed MQ status information for a specific IMS subsystem.

Using the MQSeries Status reports you can:
- view status information about the connection between an IMS and an external MQ subsystem
- track MQ status information over a period of time

Multiple Systems Coupling Reports - Overview
The Multiple Systems Coupling (MSC) reports provide detailed link information about your physical and logical links.

Using the MSC reports you can:
- evaluate and analyze your physical and logical links
- monitor the link status and queue counts of your physical and logical links
- identify logical links for a physical link
- identify links that are slow or not processing
- track MSC link activity over a period of time
Response Time Analysis Reports - Overview

The Response Time Analysis (RTA) reports provide you with a global view of transaction response times for multiple IMS systems.

Using the RTA reports you can:

- evaluate and monitor transaction response times by RTA group
- analyze response time item details for a specific RTA group
- view response time components for all RTA groups and for all items in a specific RTA group
- track response time activity over a period of time

Startup Parameters Reports - Overview

The Startup Parameters reports provide you with a global view of IMS startup parameters.

Using the Startup Parameters reports you can view detailed settings information about the IMS startup parameters.

Online TRF Class Reports - Overview

The Online TRF Class reports provide you with a global view of an IMS transaction profile.

Using the Online TRF Class reports you can:

- identify transactions that fall outside established guidelines for a transaction profile
- monitor resource utilization
- view application and code audit information
- gather information to establish transaction profiles

Online TRF DLI Reports - Overview

The Online TRF DLI reports provide you with a global view of DLI resource consumption.

Using the Online TRF DLI reports you can:

- view transaction DLI call profile information
- monitor transaction DLI efficiency
- identify unusual DLI activity

3270 Interface to OMEGAMON XE and CCC Using OMEGAVIEW, V300
Candle Command Center for Sysplex/3270

Introduction
Candle Command Center for Sysplex/3270 monitors the key components of a sysplex, including the Shared DASD, Workload Manager, Coupling Facility, Cross-System Coupling Facility, Global Enqueues, and Global Resource Serialization. It provides comprehensive, real-time information and early warning of potential problems and outages.

What Candle Command Center for Sysplex/3270 Provides
Candle Command Center for Sysplex/3270 includes the following:

Shared DASD
- Shows the systems that share a device and indicates which systems have a high response time and high I/O rate.
- Shows performance measures and exceptions presented for each system.

Workload Manager Analysis (WLM)
- Provides workflow or degradation analysis to understand components of wait time.
- Determines whether the reasons for failure to meet the goals are based on resources that WLM can accommodate, or others, such as I/O, that require use of conventional tuning methods.
- Provides information on how critical applications and workloads are performing against goals.
- Helps to determine if goals are reasonable and achievable.
- Provides individual system information in some categories that rolls up to information with plex-wide impact.

Enhanced Workflow Analysis
- Provides more details in workflow analysis for service classes, including I/O device and enqueue details.

Coupling Facility Analysis
- Provides structure status and performance information that permits you to determine whether structures are properly supporting their applications.
- Graphically presents physical connections of MVS images and coupling facility systems.
- Tracks the number and status of MVS systems connected to each coupling facility.
- Provides information about dump table storage in use.
- Provides information that enables sites to maximize use of critical resources.
- Reduces outages by indicating whether MVS images are attached.
Cross-System Coupling Facility (XCF)
- Views XCF groups and keeps track of the defined groups within the XCF systems, including number of members in the group and number of members with problems.
- Helps evaluate traffic rates so you can decide whether to redefine paths or make other hardware adjustments.

Global Enqueues Analysis
- Provides an overview of the owning tasks, waiting tasks, and the longest time any waiting task has been waiting.
- Helps to eliminate lockouts and contentions that Workload Manager cannot manage.

Global Resource Serialization (GRS)
- Provides the name of each MVS system in the Sysplex under the GRS ring, the status of the MVS image with respect to GRS, and actual and expected response time.
- Helps to ensure good GRS performance so that response time and availability are not affected.

Historical Reporting
- Provides historical information for all Workload Manager, Coupling Facility, and XCF displays.
- Helps to set expectations for attaining goals.
- Explains how to modify Workload Manager parameters to achieve expected service levels.
Candle Command Center for MQSeries/3270

Introduction

CCC for MQSeries uses the data-collection functions of the Candle Management Server® (CMS®), which runs on your MVS host.

CCC for MQSeries lets you easily collect and analyze MQSeries-specific data from a single vantage point, providing all the information you need to manage your MQSeries queue managers.

Accessing CCC for MQSeries Report Information from OMEGAVIEW

If you use OMEGAVIEW, you can access CCC for MQSeries information by zooming from the OMEGAVIEW Main Menu to the product interface. OMEGAVIEW provides you with the ability to zoom to different CCC products from one 3270 monitor. For more information about using this OMEGAVIEW feature, see your OMEGAVIEW documentation.

What CCC for MQSeries/3270 Provides

CCC for MQSeries provides the following current and historical information:

- Queue Manager Status
  
  Overview of all monitored queue managers and queue manager activity.

- Performance Data
  
  Summary of performance data for buffer manager (including the DASD page sets where buffers are written), log manager, and message manager components of an MVS queue manager.

- Queue Definitions and Statistics
  
  Definition and statistical data for all monitored queues, including the dead-letter queue.

- Channel Definitions and Performance Data
  
  Definition and performance data for all monitored CICS, APPC, and TCP/IP channels.

- Events
  
  Detailed information about events (exceptions) occurring in queue managers and channels. Event information is retrieved from local event queues on the MQSeries systems CCC for MQSeries is monitoring and can originate on that system or on a remote system whose events you are routing to a monitored local event queue.

- Applications.
  
  Statistical data and trace debugging for MVS applications, CICS transactions, and IMS programs that use MQSeries.
CCC for MQSeries/3270 Reports

The CCC for MQSeries reports provide you with detailed performance statistics about the various parts of your MQSeries system, including:

- queues
- channels
- events (such as Channel Stopped) occurring on queues and channels
- the queue manager
- the message manager
- the buffer manager and associated page sets
- the log manager

Within the Dead-Letter Queues and Queued Messages options, CCC for MQSeries also allows you to manipulate queued messages in these ways:

- browse either the message’s descriptor or its contents
- delete the message
- resend the message to its original destination (if it is on the dead-letter queue)
Introduction

Candle Corporation is committed to producing top-quality software products and services. To assist you with making effective use of our products in your business environment, Candle is also committed to providing easy-to-use, responsive customer support.

Precision, speed, availability, predictability—these terms describe our products and Customer Support services.

Included in this Guide to Candle Customer Support is information about the following:

Base Maintenance Plan ............................................................ 58
  – Telephone Support
  – eSupport
  – Description of Severity Levels
  – Service-level objectives
  – Recording and monitoring calls for quality purposes
  – Customer Support Escalations
  – Above and Beyond

Enhanced Support Services ..................................................... 62
  – Assigned Support Center Representative (ASCR)
  – Maintenance Assessment Services (MAS)
  – Multi-Services Manager (MSM)

Customer Support Contact Information ................................. 63
  – Link to Worldwide Support Telephone and E-mail information
Base Maintenance Plan

Overview
Candle offers a comprehensive Base Maintenance Plan to ensure that you realize the greatest value possible from your Candle software investments. We have more than 200 technicians providing support worldwide, committed to being responsive and to providing expedient resolutions to support requests. Technicians are available worldwide at all times during the local business day. In the event of an after-hours or weekend emergency, our computerized call management and forwarding system will ensure that a technician responds to Severity One situations within one hour. For customers outside of North America, after-hours and weekend support is provided in English language only by Candle Customer Support technicians located in the United States.

Telephone support
Candle provides consistently reliable levels of service—thanks to our worldwide support network of dedicated experts trained for specific products and operating systems. You will always work with a professional who truly understands your problem.

We use an online interactive problem management system to log and track all customer-reported support requests. We give your support request immediate attention by routing the issue to the appropriate technical resource, regardless of geographic location.

Level 0 Support is where your call to Candle Customer Support is first handled. Your support request is recorded in our problem management system, then transferred to the appropriate Level 1 support team. We provide Level 0 manual interaction with our customers because we support more than 170 products. We feel our customers would prefer personal interaction to a complex VRU or IVR selection menu.

Level 1 Support is the service provided for initial support requests. Our Level 1 team offers problem determination assistance, problem analysis, problem resolutions, installation assistance, and preventative and corrective service information. They also provide product usage assistance.

Level 2 Support is engaged if Level 1 cannot provide a resolution to your problem. Our Level 2 technicians are equipped to analyze and reproduce errors or to determine that an error is not reproducible. Problems that cannot be resolved by Level 2 are escalated to Candle’s Level 3 R&D support team.

Level 3 Support is engaged if a problem is identified in Candle product code. At Level 3, efforts are made to provide error correction, circumvention or notification that a correction or circumvention is not available. Level 3 support provides available maintenance modifications and maintenance delivery to correct appropriate documentation or product code errors.

eSupport
In order to facilitate the support process, Candle also provides eSupport, an electronic full-service information and customer support facility, via the World Wide Web at www.candle.com/support/. eSupport allows you to open a new service request and update
existing service requests, as well as update information in your customer profile. New and updated service requests are queued to a support technician for immediate action. And we can respond to your request electronically or by telephone—it is your choice.

**eSupport** also contains a continually expanding knowledge base that customers can tap into at any time for self-service access to product and maintenance information.

The Candle Web Site and **eSupport** can be accessed 24 hours a day, 7 days a week by using your authorized Candle user ID and password.

### Description of Candle severity levels

Responses to customer-reported product issues and usage questions are prioritized within Candle according to Severity Code assignment. Customers set their own Severity Levels when contacting a support center. This ensures that we respond according to your individual business requirements.

<table>
<thead>
<tr>
<th>Severity 1</th>
<th>Crisis</th>
<th>A crisis affects your ability to conduct business, and no procedural workaround exists. The system or application may be down.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severity 2</td>
<td>High</td>
<td>A high-impact problem indicates significant business effect to you. The program is usable but severely limited.</td>
</tr>
<tr>
<td>Severity 3</td>
<td>Moderate</td>
<td>A moderate-impact problem involves partial, non-critical functionality loss or a reasonable workaround to the problem. A “fix” may be provided in a future release.</td>
</tr>
<tr>
<td>Severity 4</td>
<td>Low</td>
<td>A low-impact problem is a “how-to” or an advisory question.</td>
</tr>
<tr>
<td>Severity 5</td>
<td>Enhancement Request</td>
<td>This is a request for software or documentation enhancement. Our business units review all requests for possible incorporation into a future release of the product.</td>
</tr>
</tbody>
</table>

### Candle has established the following service-level objectives:

<table>
<thead>
<tr>
<th>Call Status</th>
<th>Severity 1 Goal</th>
<th>Severity 2 Goal</th>
<th>Severity 3 Goal</th>
<th>Severity 4 Goal</th>
<th>Severity 5 Goal</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Call Time to Answer</td>
<td>90% within one minute</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level 1 Response (Normal Business Hours)</td>
<td>90% within 5 minutes</td>
<td>90% within one hour</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level 2 Response (Normal Business Hours)</td>
<td>Warm Transfer 90% within two hours</td>
<td></td>
<td>90% within eight hours</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The above information is for guideline purposes only. Candle does not guarantee or warrant the above service levels. This information is valid as of October 1999 and is subject to change without prior notice.
<table>
<thead>
<tr>
<th>Call Status</th>
<th>Severity 1 Goal</th>
<th>Severity 2 Goal</th>
<th>Severity 3 Goal</th>
<th>Severity 4 Goal</th>
<th>Severity 5 Goal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled follow-up</td>
<td>Hourly or as agreed</td>
<td>Daily or as agreed</td>
<td>Weekly or as agreed</td>
<td>Notification is made when an enhancement is incorporated into a generally available product.</td>
<td></td>
</tr>
<tr>
<td>(status update)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notification is made when a fix is incorporated into a generally available product.

The above information is for guideline purposes only. Candle does not guarantee or warrant the above service levels. This information is valid as of October 1999 and is subject to change without prior notice.
Recording and Monitoring Calls for Quality Purposes

Candle is committed to customer satisfaction. To ensure that our customers receive high levels of service, quality and professionalism, we'll monitor and possibly record incoming and outgoing Customer Support calls. The information gleaned from these calls will help us serve you better. If you prefer that your telephone call with Candle Customer Support in North America not be monitored or recorded, please advise the representative when you call us at (800) 328-1811 or (310) 535-3636.

Customer Support Escalations

Candle Customer Support is committed to achieving high satisfaction ratings from our customers. However, we realize that you may occasionally have support issues that need to be escalated to Candle management. In those instances, we offer the following simple escalation procedure:

If you experience dissatisfaction with Candle Customer Support at any time, please escalate your concern by calling the Candle support location closest to you. Ask to speak to a Customer Support manager. During standard business hours, a Customer Support manager will be available to talk with you or will return your call. If you elect to hold for a manager, you will be connected with someone as soon as possible. If you wish a return call, please tell the Candle representative coordinating your call when you will be available. After contacting you, the Customer Support manager will develop an action plan to resolve your issue. All escalations or complaints received about support issues are logged and tracked to ensure responsiveness and closure.

Above and Beyond

What differentiates Candle’s support services from our competitors? We go the extra mile by offering the following as part of our Base Maintenance Plan:

- Unlimited multi-language defect, installation and operations support
- eSupport using the World Wide Web
- Regularly scheduled product updates and maintenance provided at no additional charge
- Over 200 specialized technicians providing expert support for your Candle products
Enhanced Support Services

Overview

Our Base Maintenance Plan provides a high level of software support in a packaged offering. However, in addition to this plan, we have additional fee-based support services to meet unique customer needs.

The following are some examples of our added-value support services:

- **Assigned Support Center Representative Services (ASCR)**
  - An assigned focal point for managing support escalation needs
  - Proactive notification of available software fixes
  - Proactive notification of product version updates
  - Weekly conference calls with your ASCR to review active problem records
  - Monthly performance reviews of Candle Customer Support service levels
  - Optional on-site visits (extra charges may apply)

- **Maintenance Assessment Service (MAS)**
  - On-site assessment services
  - Advice about product maintenance and implementation
  - Training your staff to develop efficient and focused procedures to reduce overall cost of ownership of your Candle software products
  - Analysis of your Candle product environment: versions, updates, code correction history, incident history and product configurations
  - Reviews to ensure that purchased Candle products and solutions are used effectively

- **Multi-Services Manager (MSM)**
  Multi-Services Manager provides highly valued services to customers requiring on-site full time expertise to complement their technical resources.
  - Dedicated on-site Candle resource (6 months or one year) at your site to help ensure maximum use and effectiveness of your Candle products
  - Liaison for all Candle product support activities, coordination and assistance with implementation of all product updates and maintenance releases
  - Works with your staff to understand business needs and systems requirements
  - Possesses technical and systems management skills to enhance your staff’s knowledge and expertise
  - Other projects as defined in Statement of Work for MSM services
Customer Support Contact Information

Link to Worldwide Support Telephone and E-mail information

To contact Customer Support, the current list of telephone numbers and e-mail addresses can be found on the Candle Web site, www.candle.com/support/.

Select **Support Contacts** from the list on the left of the page.
### Numerics

3270 interface
- alerts and events 14
- functions 10
- reports 42
- requirements 10
- situation administration 26
- terminology 12

**A**
- access console action 32
- access console navigation 15, 30, 36
- accessing MVS-based reports 43
- accessing situations 26
- accessing SLF data 43
- action bar 43
- actions, enterprise status item 16
- adding remote session 40
- administering situations 26
- administration, situation, navigation 30
- administrator authority 39
- Adobe portable document format 8
- agent, SDM bridge 16
- aggravation 16
- alerts and causes 14
- alerts and events navigation 15, 30
- alternate access 43
- ASCR
  - assigned support center representative 62
- assigned support center representative ASCR 62
- attributes 21
- authority, report 43
- authorization, reports 39
- authorizing report access 40

**B**
- bridge agent, SDM 16
- building situations 26

**C**
- Candle Command Center for CICS 47
- Candle Management Server
  - see also CMS 29
- causes and alerts 14
- CCC for CICS console scenario 34
- CCC for CICS report viewing requirement 10
- CCC for DB2plex 48
- CCC for IMSplex 50
- CCC for MQSeries 55
- CCC for MQSeries requirement 40
- CCC for Sysplex 53
- CCC terms 12
- CCC-reports choice 43
- CICAT configuration 10, 16
- CMS connection status 16
- CMSCON 16
- CMW definitions 10, 11, 14, 32
- configuration manager 40
- connection status 16
- console access
  - 3270 interface 32
  - console navigation 15, 30, 36
  - console requirements 32
  - console scenario 34
- customer service
  - telephone support 58
- customer support
  - base maintenance plan 58
  - contact information 63
  - enhanced support services 62
  - eSupport 58
  - severity levels 59
- customized enterprise view 14

**D**
- default main status panel 16
- default status panel builder 14
- defining CCC objects 11
- defining situations 26
- definitions, CMW 14
- disable enterprise status item 14

**E**
- enterprise status item actions 16
- enterprise status item, disable 14
- enterprise view 16
- enterprise view, customized 14
- enterprise, open as events 19
- eSupport
  - customer support 58
expand function key 22
expanded predicate 22

F
F1, help 12, 23, 40
F18, zoom to CCC-report 42
F4, expand 22
F8, Fwd 40
file menu 14
formula, situation 28
functions provided, 3270 interface 10

G
granting report authority 40

H
help 12, 23
history bar, short-term 16

I
INFO status 40
information action 17
information for object 18

J
JCL requirement 39

L
listing situations 26
local session requirement 39

M
main status panel, default 16
maintenance assessment service
MAS 62
managed object, open as events 20
managed objects 17
MAS
maintenance assessment service 62
MSM 62
multi-services manager 62
multiple predicates 28
multi-services manager
MSM 62
MVS-based products 42
MVS-based report summaries 45
MVS-based reports access 43

N
navigation chart
access console 15, 30, 36
alerts and events 15, 30
situation administration 30
node 21

O
object definitions 11
object information 18
OMEGAVIEW requirement 39
open as attributes 21
open as details 17
open as events 16, 17
open as events, enterprise 19
open as events, managed object 20

P
PA2, switch key 34
panel editor 14
predicate display 21
predicate, expanded 22
predicates, multiple 28
printing problems 8

R
remote session requirement 39
remote session, adding 40
report authority 40, 43
report authorization 39
report requirements 39
report summaries 45
requirements
3270 interface 10
CCC for CICS report viewing 10
console access 10, 32
requirements, reports 39
resetting situations 27
restart situation action 27
RKANPENU ddname 39

S
scenario, console 34
SDM bridge agent 16
select console 33
session types 39
severity 16
severity levels
customer support 59
short-term history bar 16
show details action 16, 17
show formula action 28
situation administration 26
situation administration navigation 30

66  3270 Interface to OMEGAMON XE and CCC Using OMEGAVIEW, V300
situation display 21
situation formula 28
SLF 43
SLF authority 40
SNA protocol 32
start situation action 27
started task, OMEGAVIEW 39
state display 21
status panel builder, default 14
stop situation action 27
Subsystem Logging Facility
  see SLF 43
summaries, MVS-based reports 45
switch key, PA2 34
switching back to OMEGAVIEW 34

T
  telephone support
    customer service 58
terminology 12
tools menu 14

U
  undefined console 33
  user authorities 40
  using console 33

Z
  zoom to ccc-report action 42
  zooming to reports 42